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Software Overview

This user's guide describes how to use the MECcheck ™ Software. MECcheck is designed to
demonstrate compliance with the requirements of the Council of American Building Officials
(CABO) Model Energy Code (MEC) and the International Code Council (1CC) International
Energy Conservation Code (IECC). Itisthe most flexible approach for meeting the MEC
insulation and window requirements (refer to the Basic Requirements Guide in the MECcheck
Workbook for additional requirements that must also be satisfied). The MECcheck software
runs on the Microsoft Windows operating system.

The MECcheck software demonstrates compliance with the 1992, 1993, and 1995 editions of
the MEC, the 1998 and 2000 editions of the IECC, and the following state and county
residential codes. Arkansas, Georgia, Massachusetts, Minnesota, New Hampshire, Vermont,
Wisconsin, and Pima County, Arizona. The software enables you to quickly compare different
insulation levelsin different parts of your building to arrive at a package that works best for
you. A report that can be submitted with your building plans for plan review is automatically
generated.

MECcheck performs asimple U-factor x Area (UA) calculation for each building assembly to
determine the overall UA of your building. The UA that would result from a building
conforming to the code requirementsis compared against the UA for your building. If the total
heat |oss (represented as a UA) through the envel ope of your building does not exceed the total
heat |oss from the same building conforming to the code, then the software declares that you
pass. A high-efficiency equipment trade-off can also be performed.

MECcheck is appropriate for insulation and window trade-off calculationsin residential
detached one- and two-family buildings (referred to as single-family buildings) and
multifamily buildings (such as apartments, condominiums, townhouses, and rowhouses).
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Multifamily buildingsinclude residential buildings three stories or lessin height with three or
more attached dwelling units.

The New Hampshire Code appliesto residential structures under four storiesin height and commercial
structures under 4,000 square feet.

The Wisconsin Residential Code does not include multifamily buildings.

The MECcheck software generates a report that lists the insulation and window levels of your
proposed building, as well as the additional basic requirements found in the code. The Basic
Requirements Guide covers these other requirementsin detail.

Getting Started
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Conventions Used in This Guide

The MECcheck software can be used to demonstrate compliance with the 1992, 1993, and
1995 editions of the MEC and the 1998 and 2000 editions of the IECC. Although these codes
are quite similar, there are some differences in the code requirements that occasionally must be
reflected in the text of thisuser'sguide. When ablock of text or atable only appliesto a
certain edition of the code, the applicable year is printedin the margin to the left of the text or
table in the printed materials.

Codeyears or state namesin italicsindicate text is only applicable to the indicated code edition.

ALL CAPITALS- Fileand directory names are capitalized.

Bold I talics - Commands are shown in bold italics.

Bold I nitial Caps - The keys on your keyboard, such as Tab and Shift+Tab, are shown in bold initial

caps. Some keyboard short cuts require you to hold down the Alt key while pressing another key. For
example, you press Alt+Fto select the File menu. In this guide, short cuts are shown in bold type.

Italics- Anitalic typefaceis used to represent text asit appears on the screen in the program.

An arrow is used to indicate a sequence of menu and submenu sel ections, such asHelp® Help Topics.

What you Need to Run MECcheck

MECcheck requires a Windows-based computer with at least the following hardware and
software:

an 80486 processor
6 MB extended RAM
aVGA or Super VGA monitor
aMicrosoft-compatible mouse.
MECcheck is a Windows application and requires Microsoft Windows 95, 98, 2000, or NT.

Installing MECcheck

Y ou must install MECcheck onto your hard disk asinstructed below. Beforeinstalling the
software, make sure your computer meets the minimum hardware and software requirements.

Toinstall MECcheck from the CD-ROM:
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1. Insert the CD into the CD drive of your computer. The Installation dialogs will
automatically appear.

2. Follow theinstructions on the screen.
If the installation dialogs do not appear:
1. Select the Start button and choose Run from the menu.
2. Type <source>\MECchecK\setup.exe (where <source> isthe CD drive letter).
3. Click OK and follow theinstallation instructions.

Starting MECcheck

To run the MECcheck software after installation, select Programs from the Start button and
select MECcheck from the programslist. Alternatively, if you are using Windows Explorer or
File Manager, you can change to the MECcheck subdirectory and double-click on the
MECcheck icon.

Screen Layout

TitleBar - Thetitle bar displays the name of the currently open project data file and the
currently selected code. If nofileisopen, the word Untitled is displayed.

Menu Bar - The menu bar islocated directly under the title bar and displays the available
menus-File, Edit, View, Code and Help. These menus are discussed in more detail in the
following sections.

Toolbar - The toolbar contains buttons with images representing some of the same options
available in the menus.

Folder Tabs - The Project, Envelope, and Mechanical folder tabs are used to choose the
respective screens.

Buttons- The buttons located directly under the Envel ope and Mechanical folder tabs are used
to create alist of building or HVAC components.

THEBA sy

Menu Bar ——»  File Edt Yiew Options Code Tocl: Help
D ] =2 x|z 8

Toolbar———™
Project Envelope Mechanir-
Folder Tabs———™ =
Ceiling | Skylight I il I indiosy I Doar
Buttons——*
User Promptsand Status Messages - The bottom left corner of the screen displays prompts
and status messages.

Compliance Status Bar

Max. UA The Max. UAfield displays the total UA of the code building (the house built to code requirements).
To demonstrate compliance with the code, the UA of your house must be less than or equal to the UA
displayedin thisfield.
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Your UA Thefield labeled Your UA displays the UA of your proposed building based on the building
components you chose and the information you supplied about each of these components. The UA
displayed in thisfield must be less than or equal to the UA displayed in the Code UA field to
demonstrate compliance with the code.

% Better MECcheck compares the UA of your proposed house to the UA of the code house (the same house

Than Code built to code requirements). This comparison is expressed as a percentage and displayed in the %
Better (Worse) Than Codefield. The percentage gives an indication of the amount by which your
house exceeds or fails code requirements. A green percentage indicates that your home's heat lossis
less than that of the code house. A red percentage indicates that your home's heat loss exceeds that of
the code house.

Colors Used in the Software

ColorsUsed In Table Fieds
Black on white text indicates the datais editable by the user.

Black on gray text indicates the data was cal culated by the program and is not directly editable
by the user.

Dark blue on white text indicates the data was selected from adrop down list. Clicking on
such fields with the left mouse will re-display the appropriate list.

Red on white text indicates datais either missing or not within avalid range.

ColorsUsed In Compliance Fidds
Red on white compliance results indicates the design does not comply.

Green on white compliance results indicates the design complies.

Table Columns and Rows

The Envelope and Mechanical screens have grid-like tables used to enter and store data. The
rows and columns in the tables can be deleted, moved, collapsed and expanded.

Rows

Selecting Rows - To select arow, click on the tree label corresponding to that row or click on
the leftmost column of that row (the column containing row numbers). Therow will be
reversed (black background) when correctly selected. Y ou can also select multiple rows by
holding down the left mouse button on the left-hand column and dragging it over the desired
rows.

Maving Rows - Rows can be moved by:
1. selecting the row(s) to be moved (as described above),
2. releasing the mouse button,

3. clicking the mouse button on the leftmost column of any of the selected rows (a
small box will appear at thetail end of the arrow cursor),

4. dragging the mouse to the new location— athin red line will appear indicating
where the row(s) should be placed,
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5. releasing the mouse button when the red line has been placed in the desired
location.

%:é Arrow cursor when dragging rows or columns.

A singletable row can also be moved by dragging the corresponding row label in the tree
located to the left of the table. Click the mouse on the desired label and drag it to another label
onthetree. After releasing the mouse, the dragged label (and row) will be positioned directly
under the label on which it was dropped. Some restrictions apply to the placement of rows. In
the Envel ope screen, for example, window and door rows can only be placed under above-
gradewall or basement wall rows. Skylight rows can only be placed under ceiling rows.

Cdllapsing and Expanding Rows - On the Envel ope screen, rows can also be collapsed and
expanded by using the tree located to the |eft of the table. Rows that fall below a"parent” row
on the tree can be collapsed so they are not displayed. For example, an exterior wall row with
several windows and doors under it can be collapsed to hide the windows and doors. A tree
label with aminus sign to the left of the label is already expanded. It can be collapsed by
clicking on the box containing the minus sign. Tree labelsthat are already collapsed have a
plus sign to the left of thelabel. They can be expanded by clicking the box containing the plus
sign. Clicking the plus or minus sign to the left of the Building label will expand or collapse

al rowsinthetable.

Deeting Rows— Rows can be deleted by selecting the row or rows to be deleted and selecting
Delete Row(s) from the Edit menu or selecting the delete rows icon from the toolbar.

X

Multiple consecutive rows can be selected by holding down the left mouse button on the left-
hand column and dragging it over the desired rows. Non-consecutive rows can be selected by
holding down the Ctrl key while clicking on the leftmost column of each row to be selected.

In the Envelope screen, if you delete awall or basement row with windows or doors linked to
it, the windows and doors will also be deleted. Likewise, deleting a ceiling row with a skylight
linked to it will cause the skylight to be deleted aswell.

Duplicating Rows — Rows can be duplicated by selecting the row or rows to be duplicated and
selecting Duplicate Row(s) from the Edit menu or selecting the duplicate rows icon from the
toolbar.

=

Multiple rows can be duplicated, but they must be consecutive.

Columns

Selecting Columns - Select a single column by clicking the left mouse button on the column
heading. Select multiple columns by pressing the left mouse button and dragging it over the
desired column headings. Selected columnswill be reversed (black background).

Moving Columns - Columns can be moved by:
1. selecting the column(s) to be moved (as described above),
2. releasing the mouse button,

3. clicking the mouse button on the column heading of any of the selected columns
(asmall box will appear at thetail end of the arrow cursor),

4. dragging the mouse to the new location-athin red line will appear indicating
where the column(s) should be placed,
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5. releasing the mouse button when the red line has been placed in the desired
location.

Changing Column Widths- Table column widths can also be modified. To change the width
of acolumn, move the mouse over the right edge of the corresponding column header until the
mouse pointer changes to a double-sided arrow.

When the mouse pointer changes, drag the column to the desired width. Columns that have
been totally collapsed can be restored by double-clicking the mouse on the column header
separation (the vertical linein the top row representing the hidden column).

Project Folder

Y our building's location and construction type (single family or multifamily) are entered in the
Project screen. MECcheck liststhe cities or counties for each state. Thelocation and
construction type of your building are necessary for MECcheck to determine compliance. If
thisinformation is not accurate, the resultswill not be valid.

New The New Hampshire Code appliesto residential structures under four storiesin height and commercial
Hampshire structures under 4,000 square feet. Since the code isthe samefor all locations within the state, there
are no entries for location or construction type.

Wisconsin The Wisconsin Residential Code does not include multifamily buildings.

The Project screen also has input fields entitled Date of Plans Title, Project, Company, and
Notes. All of theinformation entered in these fieldsisincluded in your project report. None
of thisinformation is required by the software to determine compliance with the code. This
information may be useful, however, to the building department or as away to track and |abel
your reports.
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Whenever you exit MECcheck, the currently selected building location and construction type
are saved. When re-entering the software, the location and construction type fields are
automatically updated to reflect your last entries.

Project Folder Required Inputs

State To choose anew state, select the arrow button to theright of thefield. A list appears containing
state names. If astate codeis selected from the Code menu, the state corresponding to the new code

will bethe only one listed.

City or Each time you enter anew state, the list of cities or counties changes— reflecting only the cities or

County counties located in the new state. To choose a new location, select the arrow button to the right of
thefield. A list appears containing the names of cities or countieslocated in the selected state. If
you cannot find the city in which your building will be located, choose a city that is close to your
building site and has similar weather conditions.

New The New Hampshire state code is the same for the entire state. 1f you select New Hampshirefrom

Hampshire the Code menu, the City/County field will disappear.

Construction
Type

The code specifies different requirements for 1- and 2-family detached (single family) buildings and
multifamily buildings, so MECcheck must know which of these construction types you are going to
build. You must select either the 1- and 2-Family, Detached or the Multifamily button.

New The New Hampshire residential code appliesto all residential structures under four (4) storiesin

Hampshire height and commercial structures under 4,000 ft%. It does not distinguish between single family and
multifamily buildings. If you select New Hampshire from the Code menu, the Construction Type
optionswill disappear.

1-and 2- To choose single-family construction (defined as all detached one- and two-family dwellings), click

Family, on the 1- and 2-Family, Detached radio button with the mouse.

Detached

Multifamily To choose multifamily construction, click on the Multifamily radio button with the mouse.
Multifamily buildings are three stories or lessin height and contain three or more attached dwelling
units. Apartments, condominiums, townhouses, dormitories, and rowhouses are included in this
category. Multifamily buildings can be considered as a whole or separate reports can be generated
for each dwelling unit. Whereindividual units are identical, one report may be submitted as
representative of the others. Contact the authority having jurisdiction to determine which approach
to take.

Massachusetts If the dwelling is primarily heated with el ectric resistance heating, select the Electric Resistance

Heating button. If the dwelling is primarily heated with any other heating system, select the Other button.

System Type An electric heat pump is not electric resistance heating. The code has more stringent envelope
reguirements for single-family dwellings with electric resistance heating.

Wisconsin The code has more stringent requirements for electrically heated homes. If the dwelling is primarily

Heating heated with electric heat (including electric heat pumps), select the Electric button. If the dwelling

System Type isprimarily heated with any other non-electric heating system, select the Non-Electric button.

Sustainable If you are determining compliance to the Sustainable Energy Standard, you must enter the

Energy conditioned floor area. If thisinformation is not accurate, the results will not bevalid. The

Standard conditioned floor areaincludes the gross area of all heated and/or cooled rooms, including the floor

Conditioned area of heated or cooled basements.

Floor Area
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Project Folder Optional Inputs

The Date of Plansfield is used to record the date stamped on the building plans. This date can be used
to track the plans on which the MECcheck documentation is based, in the event that the plans are later

modified.

TheTitlefiddisasingle-line text field used to enter aproject title. Y ou can use thetitle to identify
specific projects. Thistitleisdisplayed at the top of your report.

Enter adescription of your project in the Project field (such as the project name and address).
Enter a description of your company in the Company field (such as the name and address).

Enter any additional information in the Notes field.

Envelope Folder
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Envelope Folder

The blue-on-white buttons at the top of the Envel ope screen are used for choosing the building
componentsin your proposed design. Y ou can select from buttons representing general
building components— ceilings, walls, basement walls, windows, skylights, doors, floors, slab
floors, and crawl space walls. When you select any of these buttons the component is added to
the table on the Envelope screen. The table continues to grow as you add new components.

Y ou may add as many components as you heed to describe your building, including multiple
components of the same type. The status bar message at the bottom of the screen explains
what type of information goesinto the currently selected field.

After you have filled in the information about each component, the program computes the UA
of your proposed building and the UA of the code building. The code building has the same
dimensions as your building but conforms to the code requirements. If thetotal UA of your

Softwar e User’s Guidefor all MEC and |ECC Editions



Flat Ceiling
or Scissor
Truss

Cathedral
Ceiling (no
attic)

Raised or
Energy
Truss

Structural
Insulated
Panels
(SPs)

Other

Gross Area

Cavity
Insulation
R-Value

Continuous
Insulation
R-Value

building islessthan or equal to the total UA of the code building, your building complies with
the code and the Compliance field displays the message "Passes."

Ceilings

Ceilings include opague portions of the building envelope that are above conditioned space
and are horizontal or tilted at less than 60 degrees from horizontal.

Select the Ceiling button to add a ceiling component to the description of your design onthe
Envelope screen. Each unigue ceiling assembly should be entered as a separate component,
but multiple ceiling elements sharing the same construction may be entered as one component
with appropriate total area.

Ceiling Types

After selecting the Ceiling button, a new ceiling assembly is added to the table and a popup
menu is displayed in the Assembly field. Choose from the following ceiling types:

Wood-frame ceiling structures with attics in which batt or |oosefill insulation is placed between and
on top of structural ceiling members.

Sloped, wood-frame ceiling structures without attic spaces.

Wood-frame ceiling structures with raised or oversized truss construction allowing the insulation to
achieveitsfull thickness over the plate lines of exterior walls.

Typicaly 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB). For SIPsassemblies, you must provide the manufacturer-reported R-value in the
Continuous Insulation R-Value field.

Ceiling assemblies that do not fit into any of the other ceiling types, including steel-framed roofs. If
you use the Other ceiling type, you must enter an overall U-factor for the entire ceiling assembly
(including air films). Be prepared to provide the building departrment with manufacturers' literature or
documentation of U-factor calculations.

Ceiling Software Inputs

Enter the gross area of the ceiling component in the Gross Area or Perimeter field. The gross ceiling
areaincludes the area of all skylightswithinthe ceiling. You must link the ceiling to the skylights
within that ceiling by using the tree on the | eft side of the Envelope screen. To link askylight to a
ceiling assembly, drag the skylight label on the tree to the ceiling label and release the mouse. The
ceiling area should be measured on the slope of the finished interior surface.

Enter the R-value of any insulation to be installed in the cavities between ceiling structural members,
including all blown insulation. The insulating values of other parts of the building assemblies (e.g.,
gypsum board and air films) are accounted for by the program and should not be included.

Enter the R-value of any continuous ceiling insulation. Continuousinsulation isinsulation that runs
continuously over structural members and is free of significant thermal bridging; such asrigid foam
insulation above the ceiling deck. For ventilated ceilings, insulating sheathing must be placed between

the conditioned space and the ventilated portion of the ceiling (typically applied to the trusses or rafters

immediately behind the drywall or other ceiling finish material). For structural insulated panels, enter
the manufacturer-reported R-value for the entire assembly.
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If you have selected the Other ceiling type option, enter the overall U-factor of the ceiling assembly
including exterior and interior air films. Do not include the finished ceiling in the U-factor calculation
if the space between ceiling and ceiling structureis used as an HVAC plenum. Building departments
may require supporting documentation for assemblies entered using the Other ceiling type and U-
Factor field.

Walls

Select the Wall button to add an above-grade wall component to the description of your design
on the Envelope screen. Each unique above-grade wall assembly should be entered as a
separate component, but multiple wall elements sharing the same construction may be entered
as one component with appropriate total area.

Wall Types

Wood frame wallswith 16" on-center stud spacing. The category isintended primarily for lightweight
walls but may also be used for walls with masonry veneers.

Wood frame walls with 24-in. on-center. stud spacing. The category isintended primarily for
lightweight walls but may also be used for walls with masonry veneers.

Sted frame (stud) walls of any gauge or depth, with 16" on-center stud spacing. The category is
intended primarily for lightweight walls but may also be used for walls with masonry veneers.

Steel frame (stud) walls of any gauge or depth, with 24" on-center stud spacing. The category is
intended primarily for lightweight walls but may also be used for walls with masonry veneers.

Solid precast or poured-in-place concrete aswell as concrete masonry units with grouted cells. In
making this selection, you must also indicate whether the insulation will be located on the interior or
exterior of thewall. If insulation will be placed on both the interior and exterior of the wall, select the
option corresponding to the larger insulative R-value. For example, if R-5 exterior sheathing will be
used with R-13 interior cavity insulation on afurred concrete wall, select the Interior Insulation
option. Toreceivefull credit for light-weight (insulated) concrete walls, use the Other wall type.

Concrete masonry block units with at least 50% of the cells free of grout. In making this selection,
you must also indicate whether the insulation will be located on the interior or exterior of thewall. If
insulation will be placed on both the interior and exterior of the wall, select the option corresponding
tothelarger insulative R-value. To receive full credit for light-weight (insulated) concrete walls, use
the Other wall type.

Concrete masonry block unitswith integral insulation, such as perlite or rigid foam inserts. Integral
insulation means insulation placed within the cells. Selecting thiswall type givesyou credit for
integral insulation. DO NOT enter valuesfor cavity R-value and continuous R-val ue unless additional
insulation will beinstalled. 1n making this selection, you must aso indicate whether the additional
insulation will be located on the interior or exterior of thewall. If additional insulation will be placed
on both the interior and exterior of thewall, select the option corresponding to the larger insulative R-
value. Toreceivefull credit for light-weight (insulated) concrete walls, use the Other wall type.
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Walls constructed from 5" or larger diameter logs.

NOTE: Concrete, masonry, and log wallswith 7-in or larger diameter logs receive amass wall credit in
some locations. In order to qualify for this credit, the heat capacity of the exterior wall must be greater
than or equal to 6 Btu/ft® °F [123 kj/nf °K] of exterior wall area. Masonry and concrete walls having a
mass greater than or equal to 30 Ib/ftof exterior wall area (146 kg/nf) will meet this requirement.
Masonry and concrete walls with lesser mass should be entered as wood-framed walls. Log walls with
5-inand 6-in diameter logs may be entered aslog walls, but will not receive the masswall credit.

The Vermont residential code has lesser overall thermal envelope requirements but greater heating
system efficiency requirements for log wall homes. Contact the Department of Public Serviceto find
out more about log homes and their requirements.

Typically 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB). For SIPsassemblies, you must provide the manufacturer-reported R-value in the
Continuous Insulation R-Value field.

ICFs areinsulating, stay-in-place formsfor poured concrete walls. The forms, which remain a
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels
connected with plastic ties. For ICF systems, you must provide the manufacturer-reported R-value in
the Continuous Insulation R-Value field. ThisR-Value should include air films and all materials used
in the assembly, including insulation but excluding soil effects. The effects of mortar joints and steel
framing reinforcement that penetrates insulation must be included. The R-value of the insulation only
may not be used. To determine the total assembly R-value, manufacturers may use the Series-Paralldl
method described in the ASHRAE Fundamental s Handbook, or may provide third-party independent
test results from aphysical testing laboratory. Acceptable physical testing proceduresinclude ASTM
C177, ASTM C518, ASTM C236 or ASTM C976. Tested R-value results should be included with
permit submittals.

Wall assembliesthat do not fit into any of the other above-grade wall types. Also use the Other wall
typeto receive full credit for the extrainsulative value of light-weight (insulated) concrete walls. You
must enter an overall U-factor for the entire wall assembly (including air films). Be prepared to
provide the building department with manufacturers' literature or documentation of U-factor
calculations.

Assembly U-factors entered under the Other wall type must be approved through the Department of
Commerce.

Wall Software Inputs

Enter the gross area of the wall component in the Gross Area or Perimeter field. The grosswall area
includesthe area of all windows and doors within thewall. Y ou must link the wall to the windows and
doors within that wall by using the tree on the | eft side of the Envelope screen. To link awindow or
door to awall, drag the window or door label on the tree to the wall label and release the mouse. The
grosswall area also includes the peripheral edges of floors (the area of the band joist and subfloor
between floors).

The gross area of any individual wall of a conditioned basement with an average depth less than 50%
below grade should be entered as awall (not as abasement). In this case, the grosswall areaincludes
the bel ow-grade portion of the wall and the areas of doors and windows within those walls.

Enter the R-value of any insulation to be installed in the cavities between above-grade wall structural
members. Theinsulating values of other parts of the building assembly (e.g., gypsum board and air
films) are accounted for by the program and should not be included.

MECcheck™ Version 3.0 11



Continuous
Insulation
R-Value

Assembly
U-Factor

Frame Type

Glazing
Layers

Gross Area

U-Factor

Minnesota

Enter the R-value of any continuous insulation in the above-grade wall. Continuousinsulation is
continuous over framing members or furring strips and is free of significant thermal bridging. The R-
values of other parts of the building assembly (e.g., gypsum board and air films) are accounted for by
the program and should not be entered. Insulating sheathing installed on the exterior of above-grade
wallsisan example of continuousinsulation. For structural insulated panels and insulated concrete
forms, enter the manufacturer-reported R-value for the entire assembly.

If you have selected the Other wall type, enter the overall U-factor of the above-grade wall assembly
including exterior and interior air films. Building departments may require supporting documentation
for assemblies entered using the Other wall type and U-Factor field.

Windows

Windows are defined as any transparent or translucent section in an exterior building wall
including glass block but excluding glass doors (which are entered using the Door button).
Glazing having a slope greater than 60 degrees from horizontal is considered awindow while
glazing having a slope less than 60 degrees from horizontal is considered a skylight.

Sel ect the Window button to add awindow component to the description of your design on the
Envel ope screen. Each unique window assembly should be entered as a separate component,
but multiple window elements having the same characteristics may be entered as one
component with an appropriate total area.

Windows must be linked to their corresponding wall component. Link awindow to awall by
using the tree on the | eft side of the Envelope screen. Drag the window or door label on the
tree to the wall label and release the mouse. Windowsin the exterior walls of conditioned
basements should be included in the table and should be linked to their corresponding
basement wall assembly. Windows in unconditioned basements are NOT included.

Window Types

The frame type enables you to identify the window frame material. Use Other for frame types that do
not fit into any of the other frame types.

The glazing layers enables you to identify the number of glazing layersin the windows (i.e., single,
double, or triple). Double Pane with Low-E isincluded because the performance impact of |ow-
emissivity filmsis similar to that of additional glass layers.

Window Software Inputs

Enter the area of the entire window component in square feet. Window areaisthe interior surface area
of the entire assembly, including glazing, sash, curbing, and other framing elements. The nominal area
or rough opening is also acceptable for flat windows.

Enter the U-factor for each component in its corresponding U-Factor field. U-factors for glazing must
be tested and documented by the manufacturer in accordance with the NFRC test procedure or taken
from the default glazing U-factorstablein Appendix B. Center-of-glass U-factors cannot be used.

The Minnesotaresidential code further requires that the area-weighted average U-factor of all
foundation windows 5.6 ft* and less not exceed 0.51. The area-weighted average U-factor of all
skylights may not exceed 0.55. The area-weighted average U-factor for all other windows and sliding
glass doors may not exceed 0.37.
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Skylights

Skylights are defined as any transparent or translucent section in abuilding ceiling. Glazing
having a slope | ess than 60 degrees from horizontal is considered a skylight, while glazing
having a slope greater than 60 degrees from horizontal is considered awindow.

Select the Skylight button to add a skylight component to the description of your design on the
Envelope screen. Each unique skylight assembly should be entered as a separate component,
but multiple skylight elements having the same characteristics may be entered as one
component with the appropriate total area.

Skylights must be linked to their corresponding ceiling component. Link askylight to a
ceiling by using the tree on the | eft side of the Envelope screen. Drag the skylight label on the
tree to the ceiling label and rel ease the mouse.

Skylight Types

The frame type enables you to identify the skylight frame material. Use Other for frame types that do
not fit into any of the other frame types.

The glazing layers enables you to identify the number of glazing layersin the skylights (i.e., single,
double, or triple). Double Pane with Low-E isincluded because the performance impact of |ow-
emissivity filmsissimilar to that of additional glasslayers.

Skylight Software Inputs

Enter the area of the entire skylight component in square feet. Skylight areaisthe interior surface area
of the entire assembly, including glazing and framing elements. The nominal area or rough openingis
also acceptable.

Enter the U-factor for each component in its corresponding U-Factor field. U-factors for glazing must
be tested and documented by the manufacturer in accordance with the NFRC test procedure or taken
from the default glazing U-factorstablein Appendix B. Center-of-glass U-factors cannot be used.

Doors

Select the Door button to add a door component to the description of your design on the
Envelope screen. Each unique door assembly should be entered as a separate component, but
multiple door elements sharing the same construction may be entered as one component with
the appropriate total area.

Door Types
Exterior doorsthat are mostly opague (i.e., glass covers 50% or less of the door's area).
Exterior doors that are mostly glazed (i.e., glass covers more than 50% of the door's area).

Exterior doorsthat do not fit into any of the other door types. Y ou must enter a U-factor and you
should be prepared to provide the building department with manufacturers' literature or documentation
of U-factor calculations.

Sidelites: Decorative door sidelites can beincluded with the door area and U-factor if an aggregate U-
factor isknown for the entire assembly (the door plus al sidelites). If the U-factor rating does not
include the sidelites, enter the sidelites separately as windows and use a default glazing U-factor from
thetablein Appendix B.

Door Software Inputs

Enter the total area of the door in square feet including any glazed portions. The nominal areaor
rough opening is also acceptable.

MECcheck™ Version 3.0 13



U-Factor Door U-factors must be tested and documented by the manufacturer in accordance with the NFRC test
procedure or taken from the default door U-factors table in Appendix B.

If the door is rated with an aggregate R-value (an R-value that includes both the glass and
opaque area), the following equation applies:

-F = —

U - Factor R-Vaue

If an opaque door contains glass and an aggregate R-value or U-factor rating for that door is
not available, enter the door's glass area as a separate glazing component, enter the opaque area
as an opaque door component, and enter an opague door U-factor taken from the tablein
Appendix B. The U-factorslisted in Appendix B are only for doors without glass.
Basements
Any individual wall of a conditioned basement with an average depth 50% or more below
grade should be entered using the Basement button. Walls of conditioned basements with an
average depth LESSthan 50% below grade should be entered as an above-grade wall using the
Wall button.

Select the Basement button to add a basement wall component to the description of your
design on the Envel ope screen. Each unique basement wall assembly should be entered asa
separate component, but multiple basement wall elements sharing the same construction may
be entered as one component with the appropriate total area.

2000 IECC The 2000 | ECC requires exterior foundation wall insulation to have arigid, opague, and weather-
resistant covering that prevents the degradation of theinsulation's performance. The protective
covering must cover the exposed (above-grade) area of the insulation and extend to aminimum of 6in.
(153 mm) below grade. This regquirement existsin the 2000 IECC.

Basement Wall Types

Solid Solid precast or poured-in-place concrete as well as concrete masonry units with grouted cells. To

Concrete or receive full credit for light-weight (insulated) concrete walls, use the Other basement wall type.

Masonry

Masonry Concrete masonry block unitswith at least 50% of the cells free of grout. To receivefull credit for

Block with light-weight (insulated) concrete walls, use the Other basement wall type.

Empty Cells

Masonry Concrete masonry block units with integral insulation, such as perlite or rigid foam inserts. Integral

Block with insulation meansinsulation placed within the cells. Selecting thiswall type givesyou credit for

Integral integral insulation. DO NOT enter values for cavity R-value and continuous R-val ue unless additional

Insulation insulation will beinstalled. To receive full credit for light-weight (insulated) concrete walls, use the
Other basement wall type.

Wood Wood-frame walls with any stud spacing.

Frame
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Insulated
Concrete
Forms
(ICFs)

Other

Wisconsin

ICFsareinsulating, stay-in-place formsfor poured concrete walls. The forms, which remain a
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels
connected with plastic ties. For | CF systems, you must provide the manufacturer-reported R-value in
the Continuous Insulation R-Value field. The Assembly R-Value should include air filmsand dl
materials used in the assembly, including insulation but excluding soil effects. The effects of mortar
joints and steel framing reinforcement that penetrates insulation must be included. The R-value of the
insulation only may not be used. To determi ne the total assembly R-value, manufacturers may use the
Series-Parallel method described in the ASHRAE Fundamentals Handbook, or may provide third-party
independent test results from a physical testing laboratory. Acceptable physical testing procedures
include ASTM C177, ASTM C518, ASTM C236 or ASTM C976. Tested R-value results should be
included with permit submittals.

Basement wall assembliesthat do not fit into any of the other basement wall types. Also use the Other
basement wall typeto receive full credit for the extrainsulative value of light-weight (insul ated)
concretewalls. If you use the Other basement wall type, you must enter an overall U-factor for the
entire wall assembly (including interior air film but excluding earth). Be prepared to provide U-factor
calculations or documentation from manufacturer's literature to the building department.

Assembly U-factors entered under the Other wall type must be approved through the Department of
Commerce.

Basement Software Inputs

After selecting abasement wall type, abasement wall illustration will appear with input boxes
for the basement wall height, depth below grade, and depth of insulation. Theillustration

hel psidentify the dimensions being requested. Y ou may enter basement wall dimensions
directly into thisillustration and select the OK button to have them transferred to the
corresponding row in the table on the Envelope screen. If you prefer to enter the dimensions
directly into the table on the Envel ope screen, you can select Cancel to remove theillustration
without entering dimensions. To view the basement wall illustration and inputs at alater time,
click the right-mouse button anywhere on the basement row and sel ect Edit Basement Inputs
from the popup menu.

Bazement Walls i

Enter the zpecified dimenzionz in feet [not inches] in the boxes provided. A bazement wall lezs than 50%
below grade iz conzidered an above-grade wall and must be entered using the ' all button.

|

fall Height [ft]
Measured from the i

top af the wall ta the

basement floor.

.

T:Ti
|
N NN

%

[repth of Inzulation [f]
0 Measured from the top of
the wall to where the
ihzulation stops.
Depth Below Grade [ft]
teazured from the finizhed
outzide grade to the
bazement floor,
Yy v

%

Cancel |
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(f)

Gross Area
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Continuous
Insulation
R-Value

Georgia

Minnesota

Provide the height of the wall (ft) as measured from the top of the wall to basement floor. If the height
isnot uniform, provide an average height. If you are entering a partial basement wall component (such
aswood kneewalls), enter the height of the wall section instead of the height of the entire wall.

Provide the depth (ft) that the wall extends from the finished outside grade surface to the basement
floor. If the gradeissloped or uneven, provide an average depth below grade. If you are entering a
partial basement wall component (such as wood kneewalls), enter the depth below grade of the wall
section instead of the depth below grade of the entirewall. For wood kneewalls, the wall section may
be entirely above grade, in which case you would enter 0.

Basement insulation requirements are for the full depth of the basement wall (up to 10 ft). MECcheck,
however, allows the depth of the basement wall insulation to be traded against other envelope
components. Therefore, you must indicate the depth (ft) of the insulation you intend to install on your
basement wall as measured from the top of the wall to where the insulation stops. Theinsulation must
extend from the top of the basement wall downward to a depth equal to the value entered in thisfield.
Note that for afully insulated wall the depth of insulation should be equal to the height of the wall.

For basement walls with non-uniform insulation depths, enter an average. MECcheck accepts
basement insulation depths from O to 12 ft. If you enter an insulation depth of 0, the program assumes
noinsulation isinstalled regardliess of the valuesin the Cavity Insulation R-Value and Continuous
Insulation R-Value fields.

Enter the gross area of the basement wall component in the Gross Area or Perimeter field. The gross
basement wall areaincludes the area of al windows and doors within thewall. Y ou must link the wall

to the windows and doors within that wall by using the tree on the left side of the Envelope screen. To
link awindow or door to awall, drag the window or door label on the treeto the wall label and release
the mouse.

The gross area of any individual wall of a conditioned basement with an average depth less than 50%
below grade should be entered as awall (not as a basement).

If the basement will be furred, provide the R-value of the insulation to be installed between furring in
the Cavity Insulation R-Value field. Do not include the R-value of other materials (such as interior
drywall).

Enter continuous insulation in the Continuous I nsulation R-Value field. Continuousinsulation
includes exterior rigid foam products and any continuous insulation installed on the exterior or interior
of an unfurred basement wall. For ICFs, enter the manufacturer-reported R-value for the entire
assembly in the Continuous I nsulation R-Value field.

The Georgia Residential Code does not allow bel ow-grade exterior foam plastics. If anon-zero value
is entered in the Continuous Insulation R-Value field, the output report will identify this entry as
interior continuous insulation.

R-5 is the minimum basement wall insulation R-value allowed by the Minnesota residential code.

Example 1. Wood Kneewalls

Assume a basement is to be constructed with 3-ft-high wood kneewalls built on a 5-ft-high
concrete foundation. R-13 insulation will beinstalled in the wood kneewall cavities and R-5
rigid insulation will be installed on the concrete foundation walls.

The wood kneewalls are completely above grade and fully insulated. The concrete foundation
walls are 4 ft. below grade and fully insul ated.

Create one basement wall component for the wood kneewalls and enter the following
information:

Wall Height  3ft.
DepthB.G. Oft.
Depth of Insul 3 ft.
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Create a second basement wall component for the concrete foundation and enter the following
information:

Wall Height  5ft.
DepthB.G. 4ft.
Depth of Insul  5ft.

Two basement wall components will be added to your list of building components. Provide
the grosswall area of the wood kneewalls and enter the insulation R-value as R-13 in the
Cavity Insulation R-Value field. Provide the grosswall area of the concrete foundation walls
and enter the cavity R-value as R-5 in the Continuous I nsulation R-Value field.

Example 2: Walk-Out Basement

Assume an 8-ft. basement isto be built on a slope so that the front wall is 7 ft. below grade and
therear wall istotally above grade. The ground level along both sidewallsis sloped so that
approximately 50% of each wall isbelow grade. The rear basement wall will be wood-frame
construction with R-19 cavity insulation. The other three walls will be concrete wallswith R-
10rigid insulation. All four wallswill be fully insulated.

Create one basement component for the front wall and enter the following information:
Wall Height  8ft.
DepthB.G. 7ft.
Depth of Insul  8ft.

Thetwo sidewalls are at least 50% below grade, so they are entered as a basement wall
component. If they were less than 50% below grade, they would be entered as an above-grade
wall component. Therefore, create a second basement wall component for the two side walls
and enter the following information:

Wall Height  8ft.
DepthB.G. 4ft.
Depth of Insul  8ft.

Therear wall isfully above grade and should be entered as an above-grade wall using the Wall
button. Note that the basement floor along thiswall should be considered a slab-on-grade
component. Create aslab component using the Slab button and enter the length of the
basement floor along thiswall in the Gross Area or Perimeter field.

Example 3: Below-Grade Exterior Insulation

An 8-ft. high by 21-ft. wide foundation wall is 7 ft. below grade and isto be insulated using R-
5 exterior rigid foam. Theinsulation will start at grade level and run down to the bottom of the
foundation wall. Thereis 1 foot of uninsulated exposed above-grade wall. The wall has no
openings.

Thiswall isentered in MECcheck by creating two basement wall components. The first
component will be used for entering the uninsulated above-grade portion of the wall.

Select the Basement button and enter the following information:
Wall Height 1 ft.
DepthB.G. Oft.
Depth of Insul  Oft.
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The second component will be used for entering the insulated bel ow-grade portion of the wall.
Select the Basement button again and enter the following information:

Wall Height 7 ft.
DepthB.G. 7ft.
Depth of Insul 7 ft.

After these components have been created, enter the gross area of each component and the R-
value of the insulation used on the below-grade component.

Exterior
Insulation R-5

=1 | 1" Uninsulated

v

1 | 7 insulated

Footing

Example 4: Draped Interior Insulation

Some builders choose to insulate the interior of basement walls with faced insul ation batts.
Some products have reinforced stapling tabs at the top and bottom of the batts for installation
on furring strips using a hammer-stapler. They might also be power-nailed directly to a solid
concrete or block wall or installed on pins glued directly to the foundation wall. The batts
typically comein 4-ft. widerolls, and are sometimes installed on only the top four feet of the
wall.

A solid concrete basement has 10-ft. high walls and is buried 9 ft. below grade. Foil faced, R-
11 basement batt insulation isto be installed on the first four feet of theinterior of the

basement walls. Select the Basement button, select the Solid Concrete or Masonry option, and
enter the following information:

Wall Height 10ft.
DepthB.G. 9ft.
Depth of Insul 4 ft.

With these inputs, the software will assume the lower 6 ft. of thewall is uninsulated. The R-
value of the uninsulated concrete wall is provided by the software and should not be entered by
the user. After the basement component has been created, enter the sum of the gross area of all
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exterior basement wallsin the Gross Area or Perimeter field and enter the assembly R-value
(R-11) in the Continuous Insulation R-Value field. Note that the gross area equals the sum of
the insulated and uninsulated areas.

Floors

Select the Floor button to add a floor component to the description of your design on the
Envelope screen. Each unique exposed floor assembly should be entered as a separate
component, but multiple floor elements sharing the same construction may be entered as one
component with the appropriate total area.

Floor Types

Any structural wood floor in which insulation is placed between the structural members; e.g., batt
insulation between wood floor joists.

Typically 4- to 6-in. stressed-skin panels with foam insulation sandwiched between oriented strand-
board (OSB). For SIPs assemblies, you must provide the manufacturer-reported R-value in the
Continuous Insulation R-Value field.

Floor assemblies that do not fit into any of the other floor types. Y ou must enter an overall U-factor for
the entire floor assembly (including air films). Be prepared to provide the building department with
manufacturers' literature or documentation of U-factor calculations.

For all floor types you must also indicate whether the floor islocated over an unconditioned space or
over outside air. Floors over unconditioned space include all floors over unconditioned (neither heated
nor cooled) basements, crawl spaces, and garages. Floorsover outside air include floor cantilevers,
floors of an elevated home, and floors over overhangs (such as the floor directly above arecessed
entryway or open carport). Floors over heated spaces are not part of the building envelope and should
not be included. Concrete slab-on-grade floors are entered separately using the Sab button.

Floor Software Inputs

Enter the gross area of the floor (in square feet) along the boundary where it separates conditioned
from unconditioned space.

Enter the R-value of any insulation to be installed in the cavities between floor structural members.
Theinsulating values of other parts of the building assembly (e.g., subfloor and air films) are
accounted for by the program.

Enter the R-value of any continuous floor insulation. Continuousinsulation isinsulation that runs
continuously over structural members and is free of significant thermal bridging. Theinsulating
values of other parts of the building assembly (e.g., subfloor and air films) are accounted for by the
program.

If you have selected the Other floor type option, you must enter the overall U-factor of the floor
assembly including exterior and interior air films. Building departments may require supporting
documentation for assemblies entered using the Other floor type and U-Factor field.

Slab Floors

Select the Slab button to add a concrete slab-on-grade component to the description of your
design on the Envel ope screen. Slab-on-grade componentsinclude all slab edges that are part
of the building envelope and are lessthan 12 in. below grade (i.e., all edges separating
conditioned from unconditioned space). Edges of slab floors over 12 in. below grade (such as
basement floors) are not subject to code requirements and do not need to be entered in the
software. Each unigue concrete slab/insulation combination (i.e., insulation R-value and
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2000 IECC

Unheated
Heated

Georgia

Minnesota

depth) should be entered separately, but all slabs sharing insulation methods may be entered as
asingle component with the appropriate total perimeter length.

The 2000 IECC requires slab perimeter insulation to have arigid, opaque, and weather-resi stant
covering that prevents the degradation of the insulation's performance. The protective covering must
cover the exposed (above-grade) area of the insulation and extend to aminimum of 6 in. (153 mm)
below grade. Thisrequirement existsin the 2000 IECC.

Slab Types
A slab that is not heated (see below).

A heated slab is one in which the heating elements or hot air distribution system isin contact with or
placed within the slab or the subgrade. Heated slabs have higher insulation requirements than
unheated slabs under the code.

The Georgia Residential Code does not allow bel ow-grade exterior foam plastics, but does give some
credit for carpet or hardwood on plywood applied to slab floors. If the codeis set to Georgia, you will
also be asked to indicate whether the slab is covered with either of these treatments.

R-5 is the minimum slab perimeter insulation R-value allowed by the Minnesotaresidential code.

Slab Software Inputs

After selecting aslab type, anillustration of various slab configurations will appear with an
input box for the depth of insulation. The illustration hel psidentify the dimension being
requested for various insulation configurations. Y ou may enter the depth of insulation directly
into thisillustration and select the OK button to have it transferred to the corresponding row in
the table on the Envelope screen. If you prefer to enter the insulation depth directly into the
table on the Envel ope screen, you can select Cancel to remove the illustration without entering
avalue. Toview theslabillustration at alater time, click the right-mouse button anywhere on
the slab row and select Edit Sab Input from the popup menu.
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Slab-On-Grade Floors |

Enter the depth of the insulation [ft.]. including
the total vertical and harizontal distance: ]E] ft.
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& + B = Insulation Depth

ak, I Cancel ]

Enter the depth (ft) of the insulation you intend to install as measured from the top of the slab to where
the insulation stops. This distance should include the total vertical plus horizontal distance. Refer to
the glossary definition of Slab Insulation for a description and illustration of acceptable configurations.
If you enter adepth of O, the program assumes no insulation isto be installed.

Enter the perimeter of the on-grade slab component in feet in the Gross Area or Perimeter field. The
slab perimeter should include the length of all edges of a slab foundation that are part of the building
envelope and arelessthan 12 in. below grade.

Enter the R-value of the slab perimeter insulation.

The Georgia Residential Code does not alow bel ow-grade exterior foam plastics. The Continuous
Insulation R-Value field is disabled when the code is set to Georgia.

Crawl Space Walls

The crawl space wall option isfor walls of unventilated crawl spaces (i.e. not directly vented to
the outside). If you areinsulating the floor above the crawl space, do not use the crawl space
walls option.

Select the Crawl button to add a crawl space wall component to the description of your design
on the Envelope screen. Each unique crawl space wall assembly should be entered as a
separate component, but multiple crawl space wall elements sharing the same construction
may be entered as one component with the appropriate total area.
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Crawl Space Wall Types

Solid precast or poured-in-place concrete as well as concrete masonry units with grouted cells. To
receive full credit for light-weight (insulated) concrete walls, use the Other crawl space wall type.

Concrete masonry block unitswith at least 50% of the cells free of grout. To receivefull credit for
light-weight (insulated) concrete walls, use the Other crawl spacewall type.

Concrete masonry block unitswith integral insulation, such as perlite or rigid foam inserts. Integral
insulation means insulation placed within the cells. Selecting thiswall type givesyou credit for
integral insulation. DO NOT enter valuesfor cavity R-value and continuous R-val ue unless additional
insulation will beinstalled. To receive full credit for light-weight (insulated) concrete walls, use the
Other crawl space wall type.

Wood-frame walls with any stud spacing.

ICFs areinsulating, stay-in-place formsfor poured concrete walls. The forms, which remain a
permanent part of the wall assembly, are either pre-formed interlocking blocks or separate panels
connected with plastic ties. For |CF systems, you must provide the manufacturer-reported R-value in
the Continuous R-Value field.

Crawl space wall assembliesthat do not fit into any of the other crawl space wall types. Also usethe
Other crawl space wall typeto receive full credit for the extrainsulative value of light-weight
(insulated) concrete walls. If you use the Other crawl space wall type, you must enter an overall U-
factor for the entirewall assembly (including interior air film but excluding earth). Be prepared to
provide U-factor calculations or documentation from manufacturer's literature to the building
department.

Crawl Space Wall Software Inputs

After selecting acrawl space wall type, acrawl spacewall illustration will appear with input
boxes for the crawl space wall height, depth below grade, depth of insulation, and depth below
inside grade. Theillustration helpsidentify the dimensions being requested. Y ou may enter
crawl| space wall dimensions directly into thisillustration and select the OK button to have
them transferred to the corresponding row in the table on the Envel ope screen. If you prefer to
enter the dimensions directly into the table on the Envel ope screen, you can select Cancel to
remove theillustration without entering dimensions. To view the crawl space wall illustration
and inputs at alater time, click the right-mouse button anywhere on the crawl space row and
select Edit Crawl Inputs from the popup menu.
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Unventilated Crawl Space Walls I

The crawl space wall option appliez only to wallz of unventilated crawl spaces. Enter the zpecified
dimenziohz in feet (ot inches] in the boxes provided.
Diepth of Inzulation [ft]

Wwhall Height [ft] l
Meazured from the
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top af the foating. | pluz harizontal distance.

2
i
g N F
Depth Below
> Inside Grade [ft

keazured from inzide grade
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]

Cancel I

Provide the height of the wall (ft) as measured from the sill to the top of the footing.

Provide the depth (ft) that the wall extends from the outside finished grade surface to the top of the
footing.

Provide the depth (ft) of the insulation you intend to install as measured from the top of the wall to
where the insulation stops. This distance should include the total vertical plus horizontal distance.
Because the horizontal distance isincluded, the depth of insulation may be greater than the height of
thewall. If you enter adepth of 0, the program assumes no insulation isto beinstalled.

Provide the depth (ft) as measured from the inside grade to the top of the footing.

Enter the gross area of the crawl space wall component in the Gross Area or Perimeter field. The area
should include the area of the entire wall as measured from the sill to the top of the footing, even if
only aportion of thewall isinsulated.

Provide the R-value of any insulation to be installed between structural membersin the Cavity
Insulation R-Value field. Do not include the R-value of other materials.

Continuousinsulation includes exterior rigid foam products and any continuous insulation installed on
the exterior or interior of thewall. For ICFs, enter the manufacturer-reported R-value for the entire
assembly in the Continuous I nsulation R-Value field.

The Georgia Residential Code does not alow bel ow-grade exterior foam plastics. If anon-zero value
isentered in the Continuous Insulation R-Value field, the output report will identify this entry as
interior continuous insul ation.
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Minnesota R-5 isthe minimum crawl space wall insulation R-value allowed by the Minnesota residential code.

Mechanical Folder

Use the blue-on-white buttons at the top of the Mechanical folder to enter the HVAC
equipment in your proposed design. Completion of this section of the software is entirely
optional. However, using high-efficiency HV AC equipment may improve the percentage by
which your building compares with the code building. The message at the bottom of the
screen explains what type of information goes into the currently selected field.

HVAC Efficiency

Trade-offs are allowed for efficient gas and oil furnaces, boilers, and electric heat pumps and
air conditioners. No credit isgiven for electric resistance heating.

Minimumreguired heating and cooling equipment efficiencies are displayed in the Minimum
Efficiency column. If the efficiency of the equipment you plan to install exceeds these
minimums, you qualify for the high-efficiency equipment credit. Enter the annual fuel
utilization efficiency (AFUE), heating seasonal performance factor (HSPF), or seasonal energy
efficiency ratio (SEER) in the appropriate column.

Y ou can receive credit for only one piece of heating equipment and one piece of cooling
equipment (or asingle heat pump). When multiple heating equipment or multiple cooling
equipment is entered, the least efficient equipment will be used to determine compliance.
However, if two furnaces having different efficiencieswill be installed, you may create a
single furnace entry and enter the average efficiency of both unitsin the Heating Efficiency
field. Inthis case, modify the output report to indicate that the reported efficiency isan
average. Enter the make and model number of BOTH pieces of equipment on theline
provided in the Inspection Checklist portion of the output report.

The high-efficiency equipment credit is applied as a percent increase in the code house UA.
To see how much credit you are getting, observe the UA value displayed in the Code UA field.
The UA will probably be smaller before taking the credit than after. Some locations along the
Californiacoast do not qualify for the cooling equipment credit.

Wisconsin The Wisconsin residential code requires furnaces (non-electric) to have an efficiency rating of 90% or
better to receive credit. Buildings heated with heat pumps are treated like homes with electric
resistance heating. However, credit is given for heat pumps with HSPF ratings of 7.8 or better. Boiler
systems receive credit for any value above 80%.
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Wisconsin Heating Loads

Conditioned
Floor Area

Average
Ceiling
Height
Infiltration
Rate

Equipment

Oversizing
Factor

The Wisconsin residential code requires aload calculation for sizing the heating equipment of
the building. Inthe Loadsfolder, enter values for the floor area, ceiling height, infiltration

rate, and oversizing factor. Once these values are entered into the software, the Total Building
Heating Load is calculated and can be used for selecting properly sized heating equipment.
Thetotal building heating load is the sum of the loads from the assemblies entered in the
Envel ope folder (Conductive Losses), theinfiltration loads (Infiltration Losses), and the loads
resulting from the oversizing factor (Oversizing Factor Losses).

The conditioned floor areaincludes the gross floor area of all heated rooms, including heated basement
floor area.

The average ceiling height is the area-weighted average height of the ceiling as measured from the
finished floor to the underside of the ceiling.

Theinfiltration rate is the normalized air changes per hour that is anticipated for your building. The
software will not accept values above 0.5 ACH or below 0.20 ACH.

The equipment oversizing factor is a percentage indicating the amount of oversizing you desirein
selecting your heating equipment. The software will not accept values over 15%.
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Menus

Open

The menu bar located at the top of the Envelope screen is used to select the File, Edit, View,
Code, and Help menus.

File Menu

The datayou enter into MECcheck can be stored on your hard disk in aproject datafile.
Separate data files can be created for different building projects or for alternate designs of the
same project. Datafilesallow you to retrieve and alter designs at any time. Report files allow

you to print the information you have entered and to document the compliance results
determined by MECcheck. The File menu contains options allowing you to create (New),

retrieve (Open), and save project data files and to print project reports.

Datafiles created by MECcheck must have the extension .CCK, and report files must have the
extension .RPT. If you prefer, when you are asked to provide afilename, you may leave the
extensions off and let MECcheck enter them for you.

ﬁ example.cck - MECcheck
Ele Edit “iew Options Coc
Mew Chl+M _i

Open... Chrl+0 ___
Save Clrl+5 0|
Save bz,

Frint Repaort... Chl+P =
Print Prexigw —
Print Setup....

Save Report.. i

1 example.cck

E xit

I I | T dU ST e, dCh

File Menu

The New option allows you to erase the current data and begin anew project datafile. When you
select New and unsaved data exists, MECcheck asks if you wish to save the current data. Select Yesto
save the current data or No if you do not want to save the current data. If you select Yesand afileis
already open, the open file is updated to contain the current data. If no fileisopen, the Files screen
appears and you are asked for afilename to which the datawill be saved. Y ou can also open anew

file by selecting the corresponding icon from the toolbar.

N

When you want to revise or examine an existing file, you must retrieve a copy of thefile by bringing it
to the screen. Thisisreferred to as opening thefile. The Open option allows you to open an existing
project datafile. When you select Open, the Files screen appears and you are asked for the filename
of the project datafileto retrieve. If unsaved data exists, you are asked if you wish to save the current
data before opening the new file. If an unsaved fileisaready open, you are asked if you wish to save

the currently open file before opening the new file. Y ou can also open an existing file by selecting the
corresponding icon from the toolbar.

=
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The Save option allows you to save your current data to the filename shown on thetitle bar. If nofile

isopen, the Files screen appears and you are asked for afilename. Y ou can also save data by selecting
the corresponding icon from the toolbar.

=]

The Save As option allows you to save your current project datafile to anew name. Thisoptionis

useful when an existing file is opened then modified. If you want to save copies of both the original
and the modified file, use Save Asto rename the modified file.

This option allows you to print areport listing project data and compliance results. A popup window
is displayed from which you can elect to print a Compliance Report, an Inspection Checklist, or both.
After choosing the report types to print, the Print dialog box will appear allowing you to select the
number of copies and the printer. Y ou can also print reports by selecting the corresponding icon from
thetoolbar. The print icon can be used for direct printing, in which case the printer setup dialog is not
displayed and the report is sent to the default printer.

&l

Sel ect this option to view the Compliance Report and/or Inspection Checklist before printing.

Select this option to change printer settings.

This option allows you to save areport to afile. A popup window is displayed from which you can

elect to generate a Compliance Report, an Inspection Checklist, or both. After choosing the report
types, the Save Report dialog box will appear allowing you to provide aname for thefile. The report
will be saved in Rich Text Format (RTF), which can be loaded into most text processing software.

The Exit option allows you to exit MECcheck.

Edit Menu

Use the Edit menu to cut, copy, and paste datain editable fields, and to delete and duplicate
entirerows. Editablefieldsinclude:

The Date of Plans, Title, Project, Company, and Notes fields on the Project
screen

All black-on-white (or red-on-white) fieldsin the tables on the Envel ope and
Mechanical screens

Thetree labels corresponding to these tables when in edit mode (tree labels are
put into edit mode by double-clicking on them).

m example.cck - MECcheck
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Edit Menu
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The Cut option will delete highlighted text in an editable field and copy it to the clipboard. The

deleted text can be pasted into another editablefield. Y ou can also cut text by selecting the
corresponding icon from the toolbar.

3]

The Copy option will copy highlighted text in an editable field to the clipboard. The copied text can be
pasted into another editablefield. Y ou can also copy text by selecting the corresponding icon from the
toolbar.

The Paste option will paste the last copied text into the selected field at the current cursor location.
Y ou can also paste text by selecting the corresponding icon from the toolbar.

ie]

The Delete Row(s) option will delete all selected rows. To select arow, click on the tree label
corresponding to that row or click on the leftmost column of that row (the column containing row
numbers). Multiple consecutive rows can be selected by holding down the left mouse button on the
left-hand column and dragging it over the desired rows. Non-consecutive rows can be selected by
holding down the Ctrl key while clicking on the leftmost column of each row to be selected. Y ou can
also delete rows by selecting the corresponding icon from the toolbar.

x|

The Duplicate Row(s) option will duplicate one or more consecutive selected rows. |f non-consecutive
rows are selected, this option will be disabled. To select arow, click on the tree label corresponding to
that row or click on the leftmost column of that row (the column containing row numbers). Multiple
consecutive rows can be selected by holding down the left mouse button on the left-hand column and
dragging it over the desired rows. Y ou can also duplicate rows by selecting the corresponding icon
from the toolbar.

R=

View Menu

& example.cck - MECcheck

File Edit | View Options Code To
il v Toolbar o
# v Statuz Bar ——-l

Project Envelope |

View Menu

Toggle the Toolbar option to display and hide the toolbar at the top of the screen.
Toggle the Status Bar option to display and hide the status bar at the bottom of the screen.

The Proposed and Maximum U-Val ues screen shows the maximum U-value requirements allowed by
the Minnesotaresidential code. The screen displays the maximum U-values for glazing and floors and
compares these to the area-weighted average U-values for your proposed components. If the area-
weighted average U-values of your glazing or floor components exceeds any of the maximums on this
screen, your building will not comply. If the glazing U-value maximum is exceeded, the Compliance
field will display the message Glazing Exceeds Maximumin red letters. |f the floor U-vaue maximum
is exceeded, the Compliance field will display the message Floor Uo Exceeds Maximumin red letters.
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Comments/
Description
(Envelope)

Options Menu

mexample_cck - MECcheck

File  Edit Eiew|gptigns Code Tool: Help

Commentz/Descrption [Envelope] i—
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| Project

Select this option to create a Comments/Description column on the Envelope folder. Usethe
Comments/Description column to type additional information about a building assembly that you wish
to beincluded in the Inspection Checklist, such asitslocation. The blank Comment lines provided in
the Inspection Checklist are replaced with any text entered in this column.

Code Menu

The Code menu is used to select the code edition applicable to your jurisdiction.

Envelope | Mechanical I
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AreaCalc
Take-Off
Tool

Help Topics

About
MECcheck

Cut, Copy,
Paste

Delete
Row(s),
Duplicate
Row(s)

Use Default

Edit Text

This option launches the AreaCal ¢ software tool that can be used to do building take-offs. The areas
computed in AreaCalc can be transferred directly to MECcheck.

Help Menu
The Help menu provides general information on how to use MECcheck.

g example.cck - MECcheck
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Help Menu

The Help Topics option displays the help topics avail able for MECcheck.

The About MECcheck option displays the program's version number and release date.

Context Menu

Clicking the right mouse button on atree label or table displays a pop-up list, referred to asa
context menu. The context menu options are applied to asingle field in atable or to an entire
row in atable, depending on where the mouseisclicked. If themouseisclicked on atree
label, the menu options are applied to the row corresponding to that label. If the mouseis
clicked on the left field of arow in atable, the row is selected and the options are applied to
the entirerow. Some options are applicable to individual fields of atable, and the mouse must
be clicked on the given field to activate the option.

The Cut, Copy, and Paste options are available from the Edit menu in the menu bar, from tool bar

buttons, and from the context menu. Seethe Edit Menu section for a description of these options. The
Cut, Copy, and Paste options are applied to individual fieldsin atable.

The Delete Row(s), Duplicate Row(s) options are available from the Edit menu, the toolbar, and the
context menu. Seethe Edit Menu section for a description of these options. The Delete Row(s),
Duplicate Row(s) options apply to selected rows.

The Use Default option enables you to enter adefault U-factor for windows, skylights, and doors that
do not have an NFRC rating. The Use Default option can be selected by clicking the right mouse
button in the U-Factor column of any window, skylight, or door assembly. A table of default U-
factors based on characteristics of the given assembly will be displayed. Choose the U-factor
corresponding to the characteristics of your assembly, then select the OK button to transfer this default
to the table on the Envel ope screen.

The Edit Text option is used to edit the text on atree label. When you create a new envelope assembly
or HVAC component, a new row appearsin the corresponding table and a new tree label appears on
thetreeto theleft. Thetreelabels are assigned default names such asRoof 1. These labels can be
changed by clicking the right mouse button on the label and selecting Edit Text from the context menu.
An edit box will become visible where the [abel used to be, and you can rename the label by typing in
the edit box. PressEnter or click elsewhere when finished. Y ou can enter amaximum of 32
charactersin the edit box. You can also edit tree labels by double-clicking on the label.
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Edit Inputs

Basement wall, crawl space wall, and slab-on-grade assemblies display screenswhich illustrate
dimensions being requested of the user. Y ou may enter these dimensions directly into theillustration,
then select the OK button to transfer them to the table on the Envel ope screen. Y ou may change any
previously entered dimensions directly on the table, or you may use the Edit I nputs option to redisplay
theillustration with the previously entered values. The Edit I nputs option can be selected by clicking
the right mouse button on the tree label or table row of any basement wall, crawl space wall, or slab
assembly. The option name in the context menu changes to Edit Basement Inputs, Edit Crawl I nputs,
or Edit Sab Inputs, depending on the row being selected.

Compliance Example

The software approach isillustrated in this section. Assume that you plan to build the single-
family house shown below on alot located in Greenshoro, North Carolina.
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The following table lists the components that make up the building envelope, the area of these
components, and the proposed insulation R-values and window and door U-factors. To
determine compliance, you only need to input the areas, R-values, and U-factors listed in this
table into the software, which will then display the compliance results in the Conpliance field.
If desired, you can then alter any or al of these inputsto determineif arevised design still
complieswith the code.

Determine Which Components Are Part of the Building
Envelope

Only the building components that are part of the building envelope are considered for code
compliance. Building envelope components are those that separate conditioned spaces (heated
or cooled rooms) from outside air or from unconditioned spaces (rooms that are neither heated
nor cooled). Walls, floors, and other building components separating two conditioned spaces
are NOT part of the building envelope.
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Building Component Area Insulation Level

Ceilings
With Attic (Std. Truss) 729 ft2 R-38
Vaulted 592 ft? R-30

Walls (2x4 @ 16-in. O.C.)
Without Sheathing(a) 276 ft2 (gross) R-13
With Sheathing 1647 ft2 (gross) R-19

(R-13 cavity + R-6 sheathing)

Windows 204 ft? U-0.45

Doors
Sliding Glass Doors 84 ft? U-0.61
Entrance 20 ft? U-0.54
Garage to Family Room 18 ft? U-0.35

Floors
Over Garage 363 ft2 R-19
Over Crawl| Space 575 ft? R-19
Slab (Unheated) 82 ft2 (perimeter) | R-8 (2-ft depth)
Bay Window Floor 32 ft? R-30

(a) Wallswithout sheathing are located between the family room and the garage, thelaundry

room and the crawl space, and the garage and the living room.

Table 1. Example House Specifications

Walls Inthis example, the garage is unconditioned, so the exterior garage walls are not part of
the building envelope. Thewall between the conditioned family room and the unconditioned
garageis part of the building envelope, including the wall of the stairwell facing the garage.
Likewise, the wall between the garage and the living room is part of the building envelope.

Part of the laundry room wall separates the laundry room from the crawl space and the other
part separates the laundry room from the kitchen. The wall portion adjacent to the crawl space
is part of the building envelope because it separates the conditioned laundry from the
unconditioned crawl space. Thewall portion adjacent to the kitchen can be ignored because it
separates two conditioned spaces. Thewall portion adjacent to the family room can also be
ignored. Likewise, the wall between the upstairs bathrooms and the kitchen and the wall
between the center bedroom and the living room are not part of the building envelope.
Portions of both of these walls are also adjacent to outside air, and those portions are part of
the building envelope. Thefollowing table lists the walls that are part of the building envelope
and indicates whether sheathing isinstalled on them (which isrelevant when determining the
R-value of thewall).

Wall Sheathing? |Gross Area
All walls between interior conditioned space and outsdeair Yes 1647
The wall between the family room and the garage No 192
The wall between the garage and the living room No 44
The wall between the laundry and the crawl space No 40

Celilings Thedining room, living room, bay window roof, and entryway have a vaulted ceiling
that will beinsulated to R-30. The area covered by the vaulted ceiling totals 592 ft%. The rest
of the home has a ceiling with attic which will beinsulated to R-38. Since these two ceiling
areaswill beinsulated to different levels, they must be treated as two separate building
components.

32

Softwar e User’s Guidefor all MEC and |ECC Editions



Floors The example house has a conditioned floor area of 1714 ft2, but 378 ft* of the floor
areaislocated over the family room and is not part of the building envel ope (both the family
room and the rooms above it are conditioned). Theliving room, dining room, and kitchen are
over an unheated crawl space. The family room and garage both have slab-on-grade floors.
Thefloor of the bay window isafloor over outside air.

Glazing and Doors There are two sliding glass doorsin the building envel ope — one leading
from the dining room to the larger deck and one leading from the master bedroom to the
smaller deck. There are two opaque doorsin the building envelope — the front entry door and
the door leading from the garage into the family room.

Enter the Location

On the Project folder, enter the location of the building and type of construction. Enter the
city and state as Greensboro, North Carolina, and the construction type assingle family.

Select the Code Year

This exampleis based on compliance with the 1995 MEC. Select the 1995 MEC option from
the Code menu.

Create the Building Components List

Using the buttons at the top of the Envelope folder, create building components for the entries
in Table 1. If you need more than one building component of the same type, you must enter
each component separately. For example, you will need two different ceiling components
since there are two different ceiling insulation R-values used in the example house. Select the
Ceiling button and choose All-Wood Joist/Rafter/Truss from the list of ceiling types. This
creates the first ceiling component. Repeat this step to create a second ceiling component.
Create two 16" O.C. wood-framed wall components, one window component, three door
components, two floor components (one All-Wood Joist/Truss - Over Unconditioned Space
and one All-Wood Joist/Truss - Over Outside Air), and one unheated slab component with 2'
depth of insulation. There are actually two All-Wood Joist/Truss - Over Unconditioned Space
componentsin Table 1, but they are combined since they both have the same R-value (R-19).

After the building components have been created, fill in the areas, R-values, and U-factors
from Table 1. The Code UA field should show atotal required UA of 466, and the field
labeled Your UA should show a proposed UA of 415.

Save and Print a Report

Save the data you have entered by sel ecting the Save option from the File menu. Y ou will be
asked to provide anamefor the datafile. Print acompliance report and/or inspection checklist
by selecting the Print Report option from the File menu. Y ou can exit MECcheck by selecting
the Exit option from the File menu.

Check Your Work

An examplefile (EXAMPLE.CCK) has been included with the MECcheck software.
EXAMPLE.CCK isadatafile which contains the same data used in this example. If you have
any questions, the example file can be loaded into the software to show how the building used
in this example should be entered into the software. To load thisfile, select the Open option
from the File menu.
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Changing Location Files

The following text provides instructions for changing from the city version of the MECcheck
software to the county version.

The MECcheck software contains two location files:
1. CITIES.MEC containsalist of citiesfor each state.
2. COUNTIES.MEC contains alist of countiesfor each state.

The useCounties variable contained in the CHECK_.INI file determines which of these location
filesis used by the software. To modify this variable, open the CHECK.INI filein atext
processor (preferably NOTEPAD) and set useCountiesto true or false. By default, the
software uses cities:

useCounties=false

You MUST savethisfilein an ASCII text format. The best text processor to accomplish this
isSNOTEPAD.

Noteworthy:

If you have saved adatafile for a building, the location for that building is also saved. If you
subsequently change the location file as described above and try to load that data file back into
the MECcheck software, MECcheck will not find the specified building location and will set

the location to adefault. Therefore, after loading the file into the program, you must go back

to the Project screen and resel ect your location.

Modifying the Cities or Counties

MEC and IECC code compliance is based on the heating degree-days based 65°F (HDD) of

the location in which the building resides. This section describes how locations that are not
currently available within MECcheck can be added and how the HDD values for existing
locations can be modified. Y ou should not, however, modify the HDD value for any location
without direction from your local jurisdiction. If locations are missing or incorrect for agiven
jurisdiction, we recommend that you contact the M ECcheck technical support staff and request
achange be permanently made. Otherwise, any changes will be overwritten if newer versions
of MECcheck arelater installed. Technical support contact information is given on the splash
screen that comes up when MECcheck isfirst started.

MECcheck accesses alist of cities or counties, depending on which version you are using. The
citiesare stored in afile named CITIES.MEC and the counties are stored in afile named
COUNTIES.MEC. Thesefiles come with the MECcheck software and should be located in

the same directory as the MECcheck executable file (MECCHECK.EXE).

Thefirst line of the CITIES.MEC file contains the word * cities and thefirst line of the
COUNTIES.MEC file contains the word * counties. This keyword tells the software whether
cities or counties are contained in the file, and should not be changed. The following text and
illustration apply to the cities version. However, modifications can be made to the counties
version in exactly the same manner.

The CITIES.MEC file begins with an alphabetical list of the states. The second line of thefile
contains an asterisk (*) followed by the word states. All asterisks are very important because
they delineate the sections of thefile.

Thelist of statesisfollowed by lists of citiesfor each state. The citiesfor each state are listed
separately, starting with the citiesfor Alabama. The Alabamacities start directly after theline
reading * Alabama.
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Each city name isfollowed by fifteen climate values that apply to that city. Thefirst value
represents the heating degree-days base 65°F (HDD), and the second val ue represents the
cooling degree-days base 65°F (CDD). Commas are used to separate the city name and
climate values. Commas MAY NOT be used as part of acity name. Remove extra space on
either side of all commas.

If the CITIES.MEC or COUNTIES.MEC fileis edited, care must be taken to save the new data
intext (ASCII) format. To preserve thisformat, use atext editor, such asNOTEPAD. If atext
processor such as Word Perfect or Microsoft Word is used, save thefile as DOS text or ASCI|I
text. Copy the edited fileto LOCATION.MEC.

To Add, Deete, or Modify Cities
1. Findthelist of citiesyou wish to modify.

2. Add, delete, or modify as many city lines asyou wish. Each new line must
adhere to the format described above. To add anew city, find the city in thefile
closest in location and weather to the city you want to add. Copy the existing
city lineto the correct a phabetical location for the new city. Change the city
name to the new city name. Y ou may modify the HDD and/or CDD valuesto
match the new city values, if known. Do not modify any of the other climate
data.

To Deletean Entire State
1. Deletethe state name from the list of stateslocated at the beginning of thefile.

2. Deletethelist of cities corresponding to that state. Be sureto delete all cities
AND the name of the state which precedes them.
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Appendix A: Additions

1998 IECC and 2000 IECC

What is an Addition?

1998 Additions to existing buildings must comply with code requirements when the addition is
within the scope of the code and would not otherwise be exempted. An addition isany
extension or increase in the height, conditioned floor area, or conditioned volume of a
building.

2000 Additions, alterations, and repairs to existing buildings must comply with code
requirements when the addition, alteration, or repair is within the scope of the code and
would not otherwise be exempted. An addition isany extension or increase in the height,
conditioned floor area, or conditioned volume of abuilding. An alterationisany
construction renovation, or change in the mechanical system that involves an extension,
addition, or change to the arrangement, type, or purpose of the original installation. A
repair includes the reconstruction or renewal of any part of an existing building for
mai ntenance purposes.

Additions include new construction, such as a conditioned bedroom, sunspace, or
enclosed porch added to an existing building. Additions also include existing spaces
converted from unconditioned or exempt spaces to conditioned spaces.

For example, afinished basement, an attic converted to a bedroom, and a carport
converted to aden, are additions. An unconditioned garage converted to abedroomisan
addition, but the addition of an unconditioned garage would not be considered within the
scope of the code, since the code appliesto heated or cooled (conditioned) spaces. If a
conditioned floor areais expanded, such as aroom made larger by moving out awall,

only the newly conditioned space must meet the code. A flat window added to aroom
does not increase the conditioned space and thus is not an addition by thisdefinition.
However, replacement windows that are not part of an addition must meet the

prescriptive U-factor requirements givenin Table 1.

Compliance Options for Additions

The addition (the newly conditioned floor space) complies with the codeiif it complies
with all of the applicable code requirements. For example, requirements applicable to the
addition of a new room would most likely include insulating the exterior walls, ceiling,
and floor to the levels specified in the code; sealing all joints and penetrations; installing
avapor retarder in unventilated framed walls, floors, and ceilings; identifying installed
insulation R-values and window U-factors; and insulating and sealing any ductsin
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unconditioned portions or exterior components (walls, ceilings, or floors) of the new
space.

There are three approaches by which an addition can comply with the code:

The addition as defined above meets all code requirements. This approach
does not require that the original portion of the building meet code
reguirements.

If the building with the addition complies with the code, the addition will
also comply, regardless of whether the addition complies alone. For
example, a sunroom that does not comply with the code is added to a house.
If the entire house (with the sunroom) complies, the addition also complies.

Additions less than 500 ft? (46.5 nf) of conditioned floor areamay meet the
prescriptive envelope requirementsin Tablel. To usethistable, thetotal
area of windows, doors, and skylights cannot exceed 40% of the gross wall
and roof area of the addition.

Table 1. Prescriptive Requirements for Additions and Replacement Window

Maximum Minimum
Slab
perimeter
Ceiling R-value Crawl
Climate | Fenestration | R-value | Wall Floor Basement and depth | space wall
Zone U-factor (a) () R-value | R-value | wall R-value (©) R-value (d)
1-4 0.75 R-26 R-13 R-11 R-5 R-0 R-5
5-8 0.5 R-30 R-13 R-19 R-8 R-5, 2 ft R-10
9-12 0.4 R-38 R-18 R-21 R-10 R-9, 2 ft R-19
13-15 0.35 R-49 R-21 R-21 R-11 R-13, 4 ft R-20
16-19 0.35 R-49 R-21 R-21 R-19 R-18, 4 ft R-20

a. The area-weighted average U-factor for all windows, doors, and skylightsin the
addition must not exceed the fenestration U-factor requirement.

b. Floorsover outside air must meet ceiling R-value requirements.

c. Thedab R-value requirements are for unheated slabs. Add an additional R-2 for

heated slabs.
d. The crawl space wall R-value requirements are for walls of unventilated craw! spaces
only.
2000 e. The maximum U-factor for replacement skylightsis 0.5in Zones 5-19.
2000 f. Thearea-weighted average solar heat gain coefficient (SHGC) of all windows, glazed doors, and

skylights cannot exceed 0.4 in Zones 1-7.

Replacement Windows

Replacement windows that are not part of an addition must meet the prescriptive
requirements of Table 1. A replacement window is defined as a replacement of the entire
unit, including the frame, sash, and glazing.

2 Appendix A for 1998 IECC and 2000 |IECC



Appendix B: Default U-Factors
and SHGC Values

1998 IECC and 2000 IECC

Glazing and Door Defaults

The following tables provide default U-factors and SHGC valuesfor glazing and doors based on the
glazing or door features. The U-factors and SHGC valuesin these tables can be used in the absence of
NFRC-labeled values.

Glazing and doors cannot receive credit for features that cannot be clearly detected, such as argon gas
fillsand low-emissivity (low-E) coatings. Windows with these features may achieve much lower U-
factorsthan thoselisted in Table 1. For example, a double-pane wood or vinyl window with low-E
glass may have a U-factor around 0.38. The same window with argon gas may be rated at 0.34.
Therefore, it may be advantageous to use NFRC-rated test U-factors for these types of windows.

Where a composite of materials from two different product typesis used, the window or door must be
assigned the higher U-factor.
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Table 1. U-Factors for Windows, Glazed Doors, and Skylights

Frame Material and Product Single Glazed Double Glazed
Type(a)
Metal Without Thermal Break
Operable (including sliding
and swinging glass doors) 1.27 0.87
Fixed 113 0.69
Garden window 2.60 181
Curtain wall 122 0.79
Skylight 1.98 131
Site-assembl ed sloped/ 1.36 0.82
overhead glazing
Metal With Thermal Break
Operable (including sliding
and swinging glass doors) 1.08 0.65
Fixed 1.07 0.63
Curtain wall 111 0.68
Skylight 1.89 111
Site-assembl ed sloped/ 1.25 0.70
overhead glazing
Reinforced Vinyl/Metal-Clad Wood
Operable (including sliding
and swinging glass doors) 0.90 0.57
Fixed 0.98 0.56
Skylight 175 1.05
Wood/Vinyl/Fiberglass
Operable (including sliding
and swinging glass doors) 0.89 0.55
Fixed 0.98 0.56
Garden window 231 161
Skylight 147 0.84
Glass Block Assemblies 0.60
Table 2. U-Factorsfor Non-Glazed Doors
Steel Doors
Without Foam Core 0.60
With Foam Core 0.35
Wood Doors Without Storm With Storm
Panel With 7/16-in. Panels 0.54 0.36
Hollow Core Flush 0.46 0.32
Panel With 1 1/8-in. Panels 0.39 0.28
Solid Core Flush 0.40 0.26
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Table 3. SHGC Values for Windows, Glazed Doors, and Skylights®

Single Glazed Double Glazed

Clear |Bronze| Green | Gray
+ + + +

Clear | Bronze | Green | Gray | Clear Clear Clear | Clear

Product Description

Metal frames
Operable 0.75 0.64 0.62 0.61 0.66 0.55 0.53 0.52
Fixed 0.78 0.67 0.65 0.64 0.68 0.57 0.55 0.54
Nonmetal frames
Operable
Fixed 0.63 0.54 0.53 0.52 0.55 0.46 0.45 0.44

0.75 0.64 0.62 0.61 0.66 0.54 0.53 0.52

a. SHGC values may be adjusted to reflect the effects of any permanent exterior solar shading devices,
such as shade screens.
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